Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. Our mission is to:

1. Provide a Superior Customer Experience
   • offer the best product quality and support
2. Make Cool Practical Technology
   • develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)
XPression Touch Factory · User Guide

- Ross Part Number: 3603DR-001-01
- Release Date: August 30, 2017.
- Software Issue: 01

The information contained in this guide is subject to change without notice or obligation.

Copyright

©2017 Ross Video Limited, Ross®, and any related marks are trademarks or registered trademarks of Ross Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained herein.

Patents


Notice

The material in this manual is furnished for informational use only. It is subject to change without notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

Warranty and Repair Policy

Ross Video Limited (Ross) warrants its XPression systems to be free from defects under normal use and service for the following time periods from the date of shipment:

- **XPression Server** — 12 months
- **XPression Software Upgrades** — 12 months free of charge
- **System and Media hard drives** — 12 months

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.
In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard warranty period by one year increments. For more information about an extended warranty for your XPression system, contact your regional sales manager.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.
Company Address

Ross Video Limited
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

Toll Free Technical Support: 1-844-652-0645 (North America)
+800 1005 0100 (International)

Alternately, you can contact:
Technical Support: (+1) 613 • 652 • 4886
After Hours Emergency: (+1) 613 • 349 • 0006

E-mail for Technical Support: techsupport@rossvideo.com
E-mail for General Information: solutions@rossvideo.com
Website: http://www.rossvideo.com
Overview

XPression Touch Factory is touchscreen control software for live presentations using scenes from the XPression Real-Time Motion Graphics system. It allows on-camera talent to interactively navigate graphical content, videos and animations using a touchscreen-enabled monitor.

Touch Factory supports live data through the XPression Datalinq Server. Dynamic content graphics with continuous data feeds, like elections, weather, and finance are all possible with Touch Factory.

Touch Factory operates in a client-server mode. If it is not possible to run Touch Factory directly on an XPression system, another client PC may be used to intercept the touch data for relaying back to the XPression engine.

If you are using multiple touchscreens, Touch Factory Player is available as a cost-effective read-only playback tool for presentations created from the full version of Touch Factory. There is also a remote control option for using tablets to drive presentations where the presenter does not need to turn their back to the audience to advance the content. For dual-channel XPression systems there is an option to use the second channel as an additional screen for multi-monitor productions.

Hardware Components

Touch Factory requires the following hardware components:

• Computer:
  › Windows 7 Pro Operating System
  › Full HD 1920 x1080 resolution graphics card

• Touchscreen:
  › Full HD 1920 x1080 touchscreen display resolution

• API automation (one of the following):
  › XPression Studio/Studio SCE/Studio 4K
  › XPression Studio GO!
  › XPression BlueBox/BlueBox SCE/BlueBox 4K
  › XPression Developer

• Cables:
  › SDI signal cable with an HD-SDI to HDMI converter and HDMI cable
  › DVI to HDMI cable
  › USB cable
The following diagram illustrates a basic Touch Factory hardware setup.

![Touch Factory Hardware Setup](image)

**Figure 1.1 Touch Factory Hardware Setup**

**XPression Software Version**

Touch Factory v1.0 requires XPression software version 6.5.3603 or higher.
Software Installation and Configuration

This chapter covers the following topics:

- Installing XPression Touch Factory
- Configuring XPression Touch Factory Settings
- Starting XPression Touch Factory Designer

Installing XPression Touch Factory

By default, Touch Factory is installed in the C:\XPressionApps\Touch Factory folder, and creates a Start menu folder called XPression Touch Factory that includes shortcuts to launch Touch Factory, Touch Factory Settings, and the Change History log.

Also, desktop shortcuts are created for Touch Factory and Touch Factory Settings.

To install Touch Factory:

1. Launch the Touch Factory .exe file.

   Each version of Touch Factory is developed to work with a specific version of XPression, as noted in the .exe file name. Make sure you are installing the correct version of Touch Factory for your XPression installation.

   The Touch Factory - InstallShield Wizard opens.

2. Click Next.

   The License Agreement opens.

![Install Shield Wizard Welcome Screen](image)
3. Select the **I accept the terms in the license agreement** radio button and click **Next**.
   The **Customer Information** screen opens.

4. Enter a user name in the **User Name** field and the name of your organization in the **Organization** field and click **Next**.
   The **Ready to Install the Program** screen opens.
5. Click **Install**.

   The Gateway installs and the **InstallShield Wizard Completed** screen opens.

![InstallShield Wizard Completed](image)

*Figure 2.5  Installation Complete*

6. Click **Finish**.

   The **Touch Factory - InstallShield Wizard** closes.

   If it is the first time running the installer, the **Touch Factory Settings** dialog box opens.

   If it is not the first time running the installer, and you have left the **Launch the program** checkbox checked, Touch Factory is launched.
Configuring XPression Touch Factory Settings

You can access the Touch Factory Settings dialog box from the Start menu or the desktop icon. It also automatically launches after the first time installing Touch Factory.

Use the Touch Factory Settings dialog box to configure the general, interaction, network, and client settings using the respective tabs.

Any changes made to the Touch Factory settings after the initial setup require a restart of Touch Factory to take effect.

See the following sections for details:

• General Settings
• Interaction Settings
• Network Settings
• Client Settings
• Save and Exit Settings
General Settings

Use the General tab to configure output and display settings for Touch Factory.

![Figure 2.6 Touch Factory Settings - General Tab](image)

The settings are described in the table below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Buffer</td>
<td>Enter or select the output frame buffer that Touch Factory will use for the scene.</td>
</tr>
<tr>
<td></td>
<td>Valid values: 1 and over</td>
</tr>
<tr>
<td></td>
<td>Default value: 1</td>
</tr>
<tr>
<td>Touch Overlay Screen</td>
<td>Enter or select the number of the monitor that will be used as the touch screen.</td>
</tr>
<tr>
<td></td>
<td>This monitor will run in full screen mode and detect the mouse and touch events.</td>
</tr>
<tr>
<td>Designer/Scene Setup Screen</td>
<td>Enter or select the number of the monitor that will display the Touch Factory Designer.</td>
</tr>
<tr>
<td>Opacity</td>
<td>Enter or select the level of transparency for the main window.</td>
</tr>
<tr>
<td></td>
<td>Low values are useful for testing purposes, particularly when only one monitor is used and Touch Factory is being run and displayed on the same machine with a virtual output.</td>
</tr>
<tr>
<td></td>
<td>Valid values: 1 to 100</td>
</tr>
<tr>
<td></td>
<td>Default value: 50</td>
</tr>
<tr>
<td>Line stroke size</td>
<td>Enter or select the thickness for the touch drawing/highlighter.</td>
</tr>
<tr>
<td></td>
<td>Valid values: 1 to 50</td>
</tr>
<tr>
<td></td>
<td>Default value: 10</td>
</tr>
<tr>
<td>Include Prefix in Referer Key</td>
<td>Select this checkbox to include the “button_” prefix of the source object (if it exists).</td>
</tr>
<tr>
<td></td>
<td>When a new scene is put online, the name of the object that was pressed/touched before the new scene was put online is saved as the refererButton DataLinq key, including the full name of the object.</td>
</tr>
</tbody>
</table>
Interaction Settings

Use the **Interaction** tab to configure the touch and sensitivity settings.

![Figure 2.7 Touch Factory Settings - Interaction Tab](image)

Touch Factory can detect actions from the user using a standard mouse input or a touchscreen. **Touchscreen** mode is more sensitive than **Mouse** mode but only works in newer touch displays. For testing purposes, we recommend using **Mouse** mode, since it is compatible with most of the touch devices and you can use a standard mouse to trigger Touch Factory interactions.

* The default values for the interaction settings are strongly recommended unless Touch Factory is not running properly in your system.

The settings are described in the table below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode</strong></td>
<td>Use the drop-down to select the input mode.</td>
</tr>
<tr>
<td></td>
<td>Valid values: Mouse and Touchscreen</td>
</tr>
<tr>
<td><strong>Minimum drawing distance (px)</strong></td>
<td>Enter or select the minimum distance in pixels (sensitivity) between consecutive touch actions that is going to be used for drawing a straight line between both points.</td>
</tr>
<tr>
<td></td>
<td>Valid values: 5 to 100</td>
</tr>
<tr>
<td></td>
<td>Default value: 32</td>
</tr>
<tr>
<td><strong>Minimum multitouch distance (px)</strong></td>
<td>Enter or select the minimum distance in pixels (sensitivity) between two consecutive touch actions to detect a multi-touch interaction.</td>
</tr>
<tr>
<td></td>
<td>Valid values: 5 to 100</td>
</tr>
<tr>
<td></td>
<td>Default value: 15</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Minimum scale (finger) distance (px) | Enter or select the minimum distance in pixels (sensitivity) between the two fingers while scaling a multi-touchable object.  
Valid values: 5 to 200  
Default value: 20 |
| Drawing interval (ms)         | Enter or select the amount of time in milliseconds between the drawing of one line and the next. This parameter works together with the minimum drawing distance in pixels to set the sensitivity on the drawing/highlighter functionality.  
Valid values: 10 to 1000  
Default value: 50 |
| Rotation sensitivity          | Enter or select a value to increase/decrease the sensitivity of a multi-touch rotation action.  
Valid values: 0.01 to 2.00  
Default value: 0.50 |
| Drag sensitivity              | Enter or select a value to increase/decrease the sensitivity of a multi-touch drag action.  
Valid values: 0.001 to 2.00  
Default value: 1.00 |
| Scale sensitivity             | Enter or select a value to increase/decrease the sensitivity of a multi-touch scale action.  
Valid values: 0.001 to 2.00  
Default value: 0.002 |
| Minimum scale                 | Enter or select the minimum scale value of an object if resizing it. This prevents resizing an element to such a small size that the user will not be able to interact with it.  
Valid values: -1.000 to 1.000  
Default value: 0.100 |
Network Settings

Use the **Network** tab to configure the data port and web port settings for remote operation.

![Network Tab](image)

**Figure 2.8 Touch Factory Settings - Network Tab**

The settings are described in the table below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Port</strong></td>
<td>Enter or select the number for the UDP port required for remote clients to communicate with Touch Factory when running in <strong>Server Mode</strong>.</td>
</tr>
<tr>
<td><strong>Web Port</strong></td>
<td>Enter or select the number for the TCP port required for the remote web browser to control Touch Factory.</td>
</tr>
</tbody>
</table>
Client Settings

Touch Factory supports up to two optional client applications for remote control. This is primarily designed to have one client for the touch display that is controlled using a remote computer, and a second wireless touch device (such as a tablet) that can be used by the talent.

* Remote control requires an additional license.

Use the **Client** tab to configure the Touch Factory remote client settings.

To configure the client settings:

1. In the **Client** tab, select the **Enable Client Applications** checkbox to communicate with the UDP data port defined in the **Network** tab.

   The default port is 9091. The data port number can be changed in the **Network** tab.

   The **PC (Ethernet)** and **Tablet (Wi-Fi)** settings become available.

---

**Figure 2.9** Touch Factory Settings - Client Tab (Client Applications Disabled)

**Figure 2.10** Touch Factory Settings - Client Tab (Client Applications Enabled)
2. Configure the PC or Tablet settings as follows:

**PC (Ethernet)**

a. In the **PC (Ethernet)** section, in the **Host IP** field, enter the IP address of the remote client PC.

b. In the **Port** field, enter or select the port number of the remote client PC.

   The default port is 9997.

c. If you want to stream the output framebuffer frames (at approximately one frame per second) from XPression to the client application, select the **Enable Streaming - PC** checkbox.

   You can enable streaming on up to two devices.

d. Then use the **Image Quality** drop-down to select the resolution of the frames that are streamed from XPression to the client application.

   Frames are streamed at approximately one frame per second. The options are:
   - Low (this is the default and recommended setting)
   - Medium
   - High

**Tablet (Wi-Fi)**

a. In the **Tablet (Wi-Fi)** section, in the **Host IP** field, enter the IP address of the remote client tablet.

b. In the **Port** field, enter or select the port number of the remote client tablet.

   The default port is 9998.

c. If you want to stream the output framebuffer frames (at approximately one frame per second) from XPression to the client application, select the **Enable Streaming - Tablet** checkbox.

   You can enable streaming on up to two devices.

d. Then use the **Image Quality** drop-down to select the resolution of the frames that are streamed from XPression to the client application.

   Frames are streamed at approximately one frame per second. The options are:
   - Low (this is the default and recommended setting)
   - Medium
   - High

3. Click **Save**.

   The client settings are saved and Touch Factory will operate in **Server Mode** when **Play** is pressed.

   It is recommended that the console window be enabled in Touch Factory when using client applications. To enable the console window, click **Options > Show Console** in the **Touch Factory Designer** window.

   When Touch Factory is listening to network commands, the **Touch Factory Designer** window will be hidden. This way, Touch Factory can run in the background while XPression is being used for other purposes.

   Do not use the same output framebuffer on XPression while Touch Factory is running in the background.
Save and Exit Settings

Once the Touch Factory settings have been configured, click one of the following buttons:

- To revert the settings of all tabs to the default configuration, click Default Configuration.
- To restore your last saved configuration, click Reload Configuration. Touch Factory will need to be shut down and restarted for the settings to be reloaded.
- To save the current configuration to the configuration file, click Save.
  
  The Touch Factory settings are saved to the touchfactory.cfg file located in the Touch Factory installation folder at C:\XPressionApps\Touch Factory.

- To save the current configuration and immediately launch the Touch Factory Designer, click Save & Launch.
- To exit the Touch Factory Settings without saving any changes or to exit after saving the configuration, click Exit.
Starting XPression Touch Factory Designer

The Touch Factory Designer is a tab-based, step-by-step application that allows you to define the touch workflow for your project, selecting which elements can be triggered by touch, and what will happen when the element is triggered.

Before starting Touch Factory, you will need to plug the green XPression Touch Factory USB license dongle into the internal USB port of your XPression machine.

To plug in the license dongle:

1. With all cabling unplugged and the XPression system on a flat, non-slip surface, remove the two thumbscrews at the back of the system.

Set the two thumbscrews aside, as they will be needed to replace the top panel.

2. Gently pull the top panel back towards the rear of the unit, creating a gap between the top panel of the unit and the front of the chassis.
3. Lift the top panel off the chassis.

4. Insert the USB license dongle into the USB port beside the XPression dongle, shown in the image below.
5. Replace the top panel of the XPression system as follows:
   • Face the sides of the top panel down around the sides of the system.
   • Line up the four nubs on the inside of the sides of the top panel with the L-shaped grooves on the sides of the system.

6. Gently slide the top panel into place, until a clicking noise is heard and the top panel is flush to the front top of the XPression system.
7. Insert and tighten the two thumbscrews into the back of the XPression system.

8. Reinstall your XPression system in the rack and reattach the cables.
9. Power up your XPression system.

To start XPression Touch Factory Designer:

1. Click on the XPression icon on the desktop and launch your XPression project.
2. Click on the Touch Factory icon on the desktop or select it from the Start menu.

   Touch Factory will detect the open XPression project and prompt you to continue using that project or load a new project.

3. Click Yes to load the current project.

   OR

   Click No to open the file browser window, navigate to a different project and select the XPression project file to open.

   XPression will start loading the project. Loading times vary depending on the project size.

   Once XPression finishes loading the project, the Touch Factory Designer interface opens. Touch Factory will start reading and processing the scenes and objects in the current project.

   Once the project is loaded, you can begin building the touch workflow.
The Touch Factory Designer user interface is shown in Figure 2.12.

Figure 2.12  Touch Factory Designer User Interface
Scenes and Actions Setup

This chapter covers the following topics:

- Prefixes and Definitions
- Scenes Setup
- Action Creation
- Multi Touch (Optional)
- Review Actions List
Prefixes and Definitions

This section provides information on object prefixes, DataLinq keys, and output layer indexes. This information will help you to set up your project in XPression, so that it works correctly in Touch Factory.

Object Prefixes

When creating and naming objects in XPression, you need to include specific prefixes in order to be able to assign actions to those objects in Touch Factory:

• The **button** prefix is used for identifying touchable objects.
• The **tg** prefix is used for identifying objects that you want to be able to show/hide or fade in/fade out.
• The **tg** prefix is also used on perspective camera objects that you set as target destinations (position and rotation) for creating the illusion that the main active camera is moving.
• The **multitouch** prefix is used on any 3D object that can be manipulated with multi touch actions such as drag, rotate, and scale. If you have a group of 3D objects, give each object name a **multitouch** prefix, rather than the group.

Default/Reserved DataLinq Keys

• The DataLinq key called **refererScene** is the default DataLinq key that you can set on all your Touch Factory scenes to store the source/referer SCENE name. Create this DataLinq key on each scene and it will be automatically updated as soon as you call a touchable button that triggers a scene transition.
• The DataLinq Key called **refererButton** is the default DataLinq key that you can set on all your Touch Factory scenes to store the source/referer BUTTON name. Create this DataLinq key on each scene and it will be automatically updated as soon as you call a touchable button that triggers a scene transition.

Output Layer Indexes

• Content scenes will be set online on layer 0 of the selected output framebuffer.
• The (optional) background scene will be set online on layer -3 of the selected output framebuffer.
• The (optional) crawl scene group will be set online on layer +3 of the selected output framebuffer.
Scenes Setup

In the Step 1 - Scenes Setup tab shown in Figure 3.1 you can configure the scenes for the Touch workflow. The scenes in the project you launched are listed in the Available Scenes list.

To set up scenes:

1. In the Step 1 - Scenes Setup tab, from the AVAILABLE SCENES list, select the scene to be used as a non-interactive introductory animation or image before the Main Menu Scene and click the blue Set Intro Scene button.

   This is an optional feature that is useful if you do not want to display the Main Menu Scene before you are ready to start controlling it.

   The selected scene is removed from the AVAILABLE SCENES list and applied as the introductory scene for the workflow. It is displayed in the INTRO SCENE box, as shown in Figure 3.2 and also added to the CONTENT SCENES list.

   \[ Figure 3.2 \ INTRO SCENE Section \]

   - To remove the selected Intro Scene, click the red Remove Intro Scene button.

2. From the AVAILABLE SCENES list, select the scene you want to be the first interactive scene (the main scene) and click the blue Set Main Scene button.

   If you haven’t selected an Intro Scene, the Main Menu Scene is the first scene displayed when the Touch project is launched.

   This setting is required.
The selected scene is removed from the AVAILABLE SCENES list and applied as the **Main Menu Scene** for the workflow. It is displayed in the **Main Menu Scene** box, as shown in Figure 3.3 and also added to the CONTENT SCENES list.

![Figure 3.3 MAIN MENU SCENE Section](image)

To remove the **Main Menu Scene**, click the red **Remove Main Menu Scene** button.

3. From the AVAILABLE SCENES list, select the scene you want to use as the background layer and click **Set Background Scene**.

   Setting a background scene is optional.

   The selected scene is removed from the AVAILABLE SCENES list and applied as the **Common Background Scene** for the workflow. It is displayed in the **COMMON BACKGROUND SCENE** box, as shown in Figure 3.4. Since there is no touch-sensitive content on a background scene, this scene is not added to the CONTENT SCENES list.

![Figure 3.4 COMMON BACKGROUND SCENE Section](image)

   To remove the **Common Background Scene**, select the scene and click the red **Remove Background Scene** button.

4. From the AVAILABLE SCENES list, select the scene you want to use as the common crawl layer and click the blue **Set Crawl Scene Group** button.

   This is a scene group to which you have assigned the **Crawl** effect in XPression. For information on assigning effects to scenes, see the XPression User Guide.

   This feature is optional.

   The selected scene is removed from the AVAILABLE SCENES list and applied as the **Common Crawl Group Scene** for the workflow. It is displayed in the **COMMON CRAWL GROUP SCENE** box, as shown in Figure 3.5. Since there is no touch-sensitive content on a crawl scene, this scene is not added to the CONTENT SCENES list.

![Figure 3.5 COMMON CRAWL GROUP SCENE Section](image)

   To remove the common crawl group scene, select the scene and click the red **Remove Crawl Scene** button.
5. From the AVAILABLE SCENES list, select the scenes that can be interacted with and have transitions performed between them and click the blue Add Content Scene(s) button.

Click Ctrl or Shift while selecting a scene to select multiple scenes.

![Figure 3.6 Selecting Multiple Scenes](image)

The selected scenes are added to the CONTENT SCENES list.

![Figure 3.7 CONTENT SCENES List](image)

* To remove a scene from the CONTENT SCENES list, select the scene and click the red Remove Content Scene button.
Action Creation

In the Step 2 - Action Creation tab shown in Figure 3.8 you can create the interactive actions for the Touch workflow.

![Step 2 - Action Creation Tab](image)

**Figure 3.8 Step 2 - Action Creation Tab**

In this section, you define which elements (or gestures) from a scene will be touch triggers and what you want to happen when the element is triggered. The scenes that were defined as Content Scenes in the Scene Setup tab, appear in the upper left corner of the Action Creation tab in the Source Scene list.

**To create a touch action:**

1. In the Step 2 - Action Creation tab, from the SOURCE SCENE list, select the scene in which you want to create a touchable button.

   The available touchable elements in the selected scene are listed in the SOURCE BUTTON list.

   Only elements that include the “button_” prefix and are not already in use, can be used to create an action. These elements are listed by default. To see every element in the selected scene, clear the Unused Only and Prefix only checkboxes below the SOURCE BUTTON list.
2. From the **SOURCE BUTTON** list, select an element to use as a touchable button.

   **OR**

   From the **SOURCE GESTURE** list, select a gesture to use for the scene.

   ![Figure 3.9 SOURCE BUTTON List](image)

   ![Figure 3.10 SOURCE GESTURE List](image)

   - Select **Swipe Right to Left** to use a right to left finger swipe on the touch display.
   - Select **Swipe Left to Right** to use a left to right finger swipe on the touch display.

3. From the **TARGET ACTION** section, select the action to trigger when the source button is touched or the source gesture is executed.

   There are three mutually-exclusive actions from which to choose:

   - Transition to Target Scene
   - Move Camera to Target Position
   - No Action
These actions are described in the following table.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Transition to Target Scene | Triggers a transition from the selected source scene to the target scene selected in the Transition to Target Scene list. When this action is selected, a list of transition effects is displayed in the next pane. You can select one of the following effects from the Transition Effect list:  
  • No Transition Effect  
  • Dissolve Fade  
  • Dissolve Over Black  
  • Push Right To Left  
  • Push Left To Right  
  • Push Bottom To Top  
  • Push Top To Bottom  
  • Distort Pixelate  
  You can also add a scene director action that will be executed prior to the transition action. Optionally, you can have no target action and just play the scene director. See the Play Scene Director description in Step 4 for details. |
| Move Camera to Target Position | Automatically animates the current active Perspective Camera Object (in XPression), moving and rotating it from the current position/rotation to a target position/rotation defined by another inactive perspective camera object available in the scene. Camera objects are identified by the prefix “tg_” in their name. |
| No Action                | Triggers other optional actions without triggering a transition or camera animation.                                                                                                                                 |

4. Select one of the following optional actions as the touch trigger:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Play Scene Director      | **Play Scene Director** – play the selected Scene Director animation from the source scene as soon as the source button or source gesture is triggered. If the selected target action is Transition to Target Scene, the Scene Director will play first and the corresponding transition is executed as soon as the animation ends.  
  **To play both a transition and a scene director action:**  
  1. From the SOURCE BUTTON list, select the source button for the object.  
  2. In the TARGET ACTION section, select the target scene and the transition effect you want. If you select No Action, only the Scene Director animation is played.  
  3. In the OPTIONALS section, in the Optional: Play Scene Director section, select the scene director animation you want to play.  
  4. Then go to Step 6.  

---
6. Click the blue **+Add New Touch Action** button to create the touch action.

The touch action is added to the **BUTTON ACTIONS LIST** in the **Review - Actions List** tab.

If you change your mind about the target action you assigned to the button or gesture, go to the **Review - Actions List** tab and remove the action from the relevant list.
Multi Touch (Optional)

In the Step 3 (Optional) - Multi Touch tab shown in Figure 3.11 you can add multi touch actions to selected 3D objects.

Touch Factory lists the 3D objects from the current project that include the “multitouch_” prefix in their name.

To enable multi touch action for an object:

1. In the Step 3 (Optional) - Multi Touch tab, in the MULTI TOUCH OBJECTS AVAILABLE list, click the 3D object(s) you want to enable.

2. Select a multi touch action to enable it for the selected 3D object.

   The options are as follows:

   • **Rotate X** – detects the position of one finger on top of the object and rotates the object along the X axis.
   • **Rotate Y** – detects the position of one finger on top of the object and rotates the object along the Y axis.
   • **Scale (X, Y, Z)** – detects the position of two fingers over the object and scales it proportionally along the X axis, Y axis, and Z axis depending on the distance between the two fingers.
   • **Drag (X, Y)** – detects the position of one finger over the object and moves the object vertically and horizontally along the X axis and Y axis.

   ✳ **Rotate** and **Drag** multi touch actions cannot be enabled simultaneously for the same object.

3. Click the blue Add Object button to enable the multi touch object.

   The 3D objects that have been assigned multi touch behaviors will be listed in the MULTI TOUCH OBJECTS ENABLED list.

   ✳ To remove a multi touch object, select the object from the MULTI TOUCH OBJECTS ENABLED list and click the red Remove Object button.
Review Actions List

In the **Review - Actions List** tab shown in **Figure 3.12** you can review the touch actions you created for your project and remove any actions that you decide you don’t want or want to change. You can also see a workflow diagram for each scene that contains touchable elements.

![Figure 3.12 Step 4 - Review-Actions List Tab](image)

**Figure 3.12** Step 4 - Review-Actions List Tab

**To delete a touch action:**

1. In the **Review - Actions List** tab, from any of the action lists, select the touch action you want to delete.
2. Click the red **Remove Selected Action(s)** button beneath the list.
To view a workflow diagram:

1. Below the **BUTTON ACTIONS LIST**, click the grey **Preview Actions Diagram** button.
2. From the **Scene** drop-down list, select the scene for which you want to view the workflow diagram.

The workflow diagram for the selected scene is generated, showing the source scene, corresponding target scenes, and the button objects that trigger the actions. See **Figure 3.13**.

![Figure 3.13 Workflow Diagram](image)

To close the workflow diagram and return to the **Review-Actions List** tab, click the X in the top right corner.

To export the workflow diagram:

1. Click the yellow **Export Diagram** button.
2. In the **Save As** dialog, navigate to the folder in which you want to save the workflow diagram.
3. In the **File name** field, enter a name for the diagram and then click **Save**.

The workflow diagram is saved as a JPEG image file in the selected folder.
Operation

This chapter covers the following topics:

• Saving and Loading Files
• Viewing the Console Window
• Playing a Touch Workflow
• Making Changes to Your XPression Project
Saving and Loading Files

The current Touch Factory workflow configuration can be saved to a Touch Factory Setup File (extension .tsf). Additional metadata elements will be added to the XPression project. Saving a Touch Factory workflow to file is required to load it at a later time on the machine as well as on other remote machines with Touch Factory Player.

To save a file:

1. In the Touch Factory Designer Menu bar, select File > Save workflow/configuration file or click the green Save & Export Current Touch App workflow button.

   The Save and Export Confirmation window opens.

   ![Save and Export Confirmation Dialog](image1)

   *Figure 4.1 Save and Export Confirmation Dialog*

2. Click OK.

   The confirmation window closes and the Save As file browser opens.

   ![Save As Dialog](image2)

   *Figure 4.2 Save As Dialog*

3. Select a location in which to save the workflow configuration file and click Save.
To load a file:

1. In the **Touch Factory Designer Menu** bar, select **File > Load workflow/configuration file**.
   The **Open** file browser opens.

   ![Open File Browser](image)

   **Figure 4.3** Open File Browser

2. Locate and select the workflow configuration file to load and click **Open**.
   The workflow is loaded in the **Touch Factory Designer**.
Viewing the Console Window

Use the **Touch Factory - Console Window** to test and debug a project while creating a new workflow. The Console Window displays the X,Y coordinates of touch display or mouse click events, the names of the corresponding objects being touched, and the actions being triggered.

To open the console window:

- In the **Menu** bar, click **Options > Show Console**. When selected, a check mark will be displayed next to the option in the menu.
Playing a Touch Workflow

Additional applications or machines are not needed to play a Touch Factory project workflow. After creating or loading touch actions, you can play the project on the current machine.

To play the Touch project:

• Click the green Play button in the Touch Factory Designer window.

To stop playing the Touch project:

• Press the Esc key.

Additional Play Settings

Some functionalities can be enabled/disabled when playing the Touch project. These additional play settings are located on the right side of the Touch Factory Designer window, above the green buttons.

Scene Directors and Transitions

Enable Scene Directors Triggers – Select this checkbox to play the optional Scene Director animation triggers.

Enable Transition Effects – Select this checkbox to play transition effects while performing transitions from one scene to another.

Miscellaneous Settings

• Fade Effect from Intro to Main – Select this checkbox to use a Dissolve Fade effect as the transition between the Intro Scene and Main Scene.
  
  If an Intro Scene has been set, selecting this checkbox will trigger the transition between the Intro Scene and the Main Menu Scene as soon as the user touches any part of the touch display. You don’t need to create a button to transition from the Intro Scene to the Main Menu Scene.

• Show Background in Main – Select this checkbox to display the Common Background as a background layer (Layer -3) while the Main Menu Scene is online (Layer 0).
  
  By default, the Common Background is not shown while the Main Menu Scene is online.

• Show Crawl in Main – Select this checkbox to display the Common Crawl scene group (Layer +3) while the Main Menu Scene is online (Layer 0).
  
  By default, the Common Crawl group scene is not shown while the Main Menu Scene is online.

• Top Most – Select this checkbox to display the Touch Factory Designer on top of other application windows that are running on the XPression machine.

• Clear Frame Buffer on ESC – Select this checkbox to clear the current output framebuffer when the Touch project is stopped (by pressing the Esc key).
  
  By default, this checkbox is enabled.
**Draw Mode / Highlighter**

**Enable Draw Mode** – Select this checkbox to use the touch highlighter functionality when playing the Touch project. Select the checkbox before clicking **Play**.

When **Draw Mode** is enabled, there will be a pen image in the lower left corner of the screen as an overlay on top of the XPression output. Click on the pen image to activate it and use the highlighter to draw freehand yellow curved lines on top of the graphics.

![Figure 4.5 Draw Mode Enabled](image)

Click on the pen image again to deactivate it and remove the lines that were drawn.

When **Draw Mode** is deactivated the pen image is visible, but greyed out.

![Figure 4.6 Draw Mode Deactivated](image)

The talent can turn the highlighter on or off while online. When the highlighter is activated, no other touch actions are executable.

**Making Changes to Your XPression Project**

When you have a project open in both XPression and Touch Factory, changes you make in XPression to any scene or object are automatically saved in Touch Factory. You can review your changes by playing the touch project.

If you create a new scene or object, you need to close and reopen Touch Factory and load the updated project. You will then need to go through the **Scenes Setup** and **Action Creation** procedures again.
Remote Configuration

When the Touch Display cannot be connected directly to the XPression machine, Touch Factory can be used remotely.

Remote control of Touch Factory is a separate, purchasable option. Contact your Ross Video salesperson for details about purchasing the remote client application option for Touch Factory.

This chapter covers the following topics:

- Touch Factory Client Setup
- Touch Factory Setup
- Client Configuration
- Running the Touch Factory Client
Touch Factory Client Setup

Touch Factory can be controlled remotely via a computer (Ethernet) or tablet (Wi-Fi).

Hardware Setup

If using an Ethernet connection to a computer, use the following procedure to connect the Touch Factory hardware for use with the client computer.

**To set up the client hardware:**

1. Connect port one of the touch display to the client computer display output.
2. Connect port two of the touch display to the XPression output signal.
   
   This might require an SDI to HDMI converter.
3. Connect the touch display USB port to the client computer.

Software Setup

Install the Touch Factory Client software on the remote computer that has the touch display connected.

By default, the Touch Factory Client is installed in the `C:\XPressionApps\Touch Factory Client` folder, and creates a **Touch Factory Client** icon on the desktop and a **Touch Factory** folder in the **Start** menu.

**To install Touch Factory Client:**

1. Launch the **Touch Factory Client** file.
   
   The **Touch Factory Client - InstallShield Wizard** opens.

![Touch Factory Client - InstallShield Wizard](image)

**Figure 5.1** Touch Factory Client - InstallShield Wizard
2. Click Next.  
   The License Agreement dialog opens.

   ![License Agreement](image1.png)

   *Figure 5.2 License Agreement*

3. Select the I accept the terms in the license agreement radio button and click Next.  
   The Customer Information dialog opens.

   ![Customer Information](image2.png)

   *Figure 5.3 Customer Information*

4. Enter a user name in the User Name box and the name of your organization in the Organization box and click Next.
The **Ready to Install the Program** dialog opens.

![Figure 5.4 Ready to Install the Program](image)

5. Click **Install**.

The **InstallShield Wizard Completed** dialog opens.

![Figure 5.5 InstallShield Wizard Completed](image)

6. Click **Finish**.
**Touch Factory Setup**

To use Touch Factory remotely, the network and client settings need to be configured in the **Touch Factory Settings**. See **Network Settings** and **Client Settings** for configuration details.

If you are using the Touch Factory software on your own equipment, you may need to add an exception to your firewall settings to allow communication with the Client application.

**To change allowed apps:**

1. Click Start and enter the word “firewall.”
2. From the list that appears, select **Windows Firewall** (not Windows Firewall with Advanced Security).
3. From the list of settings on the left side of the **Windows Firewall** screen, select **Allow an app or feature through Windows Firewall**.
4. Click **Allow another app...** beneath the bottom-right corner of the list of **Allowed apps and features**.
   - If the **Allowed apps and features** button is not enabled, click **Change Settings** and give yourself permission to make changes or add new apps.
5. Browse to and select the Touch Factory Client application.
6. Click the **Network Types** button to specify whether to allow access on public or private networks (or both).
7. Then click Add.

**Client Configuration**

The Touch Factory Client configuration file can be edited directly.

**To edit the Touch Factory Client configuration file:**

1. Open the **tfclient.cfg** configuration file located in the **Touch Factory Client** folder (C:\XPressionApps\Touch Factory Client).
   - The following text displays the configuration file structure with sample initial data:

   ```xml
   <?xml version="1.0" encoding="utf-8"?>
   <touch_factory>
   <xpression port="9091" ip="127.0.0.1" image_port="9997" />
   <click_mode>2</click_mode>
   </touch_factory>
   ```
2. Replace the **ip** value with the IP address of the XPression machine and, if necessary, change the **xpression port** value from **9091** to the number of the port used on the Touch Factory side.
3. Update the **image_port** value to match the configuration on the Touch Factory side, if necessary.
4. Edit the **click_mode** value.
   - The **click_mode** parameter defines whether the Touch Actions from the touch display will be detected as **Mouse** mode (1) or as **Touch** mode (2). The default is **Touch** mode (2).
   - Standard touchscreens support both **Touch** mode and **Mouse** mode.
   - Some older touchscreens support **Mouse** mode only. If **Touch** mode is selected for a touchscreen that only supports **Mouse** mode, the user input won’t be detected at all.
   - In some cases, using a KVM (keyboard, video and mouse) switch may disable **Touch** mode.
   - For assistance in determining the appropriate mode selection, contact Ross Technical Support.
5. Once the configuration is complete, save the updated configuration file.
Running the Touch Factory Client

Touch Factory Client will detect local touch events and forward them to the remote XPression machine. You can check the Console Window to see if touch events are being received on the Touch Factory server side.

If the client applications have not been enabled in the Touch Factory settings, a full screen XPression Touch Factory logo will be displayed on the Touch Factory Client application display:

![Figure 5.6 Client Applications Not Enabled](image)

If the client applications are enabled in the Touch Factory settings, a preview image of the XPression output framebuffer will be streamed through the network and displayed on the Touch Factory Client application display.

To run the Touch Factory Client:

• After configuring the Touch Factory Client, double-click the Touch Factory Client desktop icon on the client application.

★ Launch the Touch Factory Client first and then launch Touch Factory to stream the XPression output framebuffer frames to the Touch Factory Client application through the network. This feature will not work if the virtual output is being used as the XPression output framebuffer.

To close the Touch Factory Client:

• Press Esc.
Touch Factory Player

Touch Factory Player is designed to run Touch Factory projects in an automated configuration.

Touch Factory Player will run in the background on the corresponding XPression machine. It is populated with a list of preconfigured Touch Factory projects that are automatically enabled as soon as the corresponding XPression projects are loaded and its scenes are set online.

Touch Factory Player can be very useful for using Touch Factory projects in News rooms / MOS workflows, where Projects and Scenes are loaded and set online from Sequencer and third party applications.

The XPression user interface is not required, so Touch Factory Player can run seamlessly in an XPression Bluebox system.

A Touch Factory (Designer) license dongle or a specific Touch Factory Player dongle is required to run the application.

Touch Factory Player is designed to run with XPression 6.5.3600 or later.

This chapter covers the following topics:

- Installing Touch Factory Player
- Configuring Touch Factory Player
- Starting Touch Factory Player in Server Mode
- Starting Touch Factory Player in Standalone Mode
- Closing Touch Factory Player
- Keyboard Shortcuts for Running Touch Factory Player in Standalone Mode
Installing Touch Factory Player

This section of the user guide describes how to install Touch Factory Player.

To install Touch Factory Player:

1. Double-click the **Touch Factory Player.exe** file.
   The *Welcome* screen for the installation wizard opens.

   ![Welcome screen](Figure%206.1%20Touch%20Factory%20Player%20Installation%20-%20Welcome)
   *Figure 6.1  Touch Factory Player Installation - Welcome*

2. Click *Next*.
   The *License Agreement* dialog opens.

   ![License Agreement dialog](Figure%206.2%20Touch%20Factory%20Installation%20-%20License%20Agreement)
   *Figure 6.2  Touch Factory Installation - License Agreement*
3. Select I accept the terms of the license agreement and click Next.
   The Customer Information dialog opens.

   ![Figure 6.3 Touch Factory Installation - Customer Information]

4. Enter your Username and Organization and click Next.
   The Ready to Install the Program dialog opens.

   ![Figure 6.4 Touch Factory Player - Ready to Install Program]
5. Click **Install**.

By default, Touch Factory Player will be installed in the `C:\XPressionApps\Touch Factory Player\` folder. When the installation is complete, the **InstallShield Wizard Completed** dialog opens.

![Figure 6.5 Touch Factory Player - Installation Complete](image)

6. Click **Finish**.

The installation will create a Touch Factory Player icon on the desktop and a Touch Factory Player shortcut in the **Start** menu.
Configuring Touch Factory Player

This section of the user guide describes how to configure the Touch Factory Player. See the following topics for instructions:

- Adding and Removing Project Files
- Showing/Hiding the Console
- Enabling/Disabling the Extended Console
- Configuring Settings

Adding and Removing Project Files

The project files (with the extension .tsf) are the workflow files created in Touch Factory Designer. They assign touch events to selected scene elements in an XPression project.

To add a project file:

1. Right-click the Touch Factory Player icon in the system tray.
2. From the context menu, select Add Touch Project (.tsf).
3. In the Open dialog, browse to the location of your Touch Factory project files, select a file and click Open.

The selected file is added to the Touch Factory Player project list.
To remove a project file:

1. Right-click the Touch Factory Player icon in the system tray.
2. From the context menu, select **Remove Touch Project**.

![Configuration Menu - Remove Touch Project](image)

Figure 6.8 Configuration Menu - Remove Touch Project

The Select Project(s) dialog opens.

![Select Project(s)](image)

Figure 6.9 Select Project(s)

3. Select the project you want to remove and click **Remove**.
   The selected project is deleted from Touch Factory Player.

**Showing/Hiding the Console**

The Touch Factory Player Console displays a log of events.

To show the console:

1. Right-click the Touch Factory Player icon in the system tray.
2. From the context menu, select **Show Console**.

![Configuration Menu - Show Console](image)

Figure 6.10 Configuration Menu - Show Console

The console appears onscreen. In the context menu, a checkmark is displayed beside **Show Console** to indicate that the console is open.

3. Click the **Minimize** button in the top-right corner to minimize the console to the system tray.
To hide the console:

1. Right-click the Touch Factory Player icon in the system tray.
2. From the context menu, select **Show console**.

The console closes and the **Show Console** menu item is no longer checked.

Enabling/Disabling the Extended Console

The extended console displays additional log information while Touch Factory Player is running. This can be useful for debugging new projects and for understanding what’s happening in the Touch Factory Player application.

To enable the extended console:

1. Right-click the Touch Factory Player icon in the system tray.
2. From the context menu, select **Enable Extended Console**.

![Configuration Menu - Enable Extended Console](image)

*Figure 6.11 Configuration Menu - Enable Extended Console*

The console appears, if it’s not already onscreen. In the context menu, a checkmark is displayed beside the **Enable Extended Console** menu item to indicate that this option is enabled.

To disable the extended console:

1. Right-click the Touch Factory Player icon in the system tray.
2. From the context menu, select **Enable Extended Console**.

The console closes and the **Enable Extended Console** menu item is no longer checked.
Configuring Settings

Touch Factory Player configuration settings are grouped into the following areas:

- General Settings
- Window Settings
- Interaction Settings
- Client Settings

When you have finished configuring the settings, save them to the `touchfactory.cfg` file. See Saving Settings for more information.
General Settings

In the **General** tab you can select the application mode, specify the XPression output framebuffer and layer and enable the Web server.

![Figure 6.12 Touch Factory Player Settings - General Tab](image)

The settings are described in the table below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application Mode</strong></td>
<td>In <strong>Server</strong> mode, Touch Factory Player acts as a listener, running in the background, that will detect Touch projects and scenes that are externally set online and enable touch interaction with them, through a remote Touch Factory Client device. This is the default setting. In <strong>Standalone</strong> mode, Touch Factory Player displays the fullscreen window locally and detects the touch events from a touch display directly connected to the XPression machine. Requires an application restart.</td>
</tr>
<tr>
<td><strong>XPression Output</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Frame Buffer</strong></td>
<td>Enter or use the arrows to select the output framebuffer that Touch Factory will use for the scene. Valid values: 1 and over Default value: 1</td>
</tr>
<tr>
<td><strong>Layer</strong></td>
<td>Enter or use the arrows to select the layer index that will be used for detecting when Touch scenes are being set online.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Web Server</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Enabled</strong></td>
<td>Check to enable the internal Web server. Requires a Touch Remote license.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>The TCP Port number of the Web server being used to control Touch Factory from a remote Web browser. This value must be something other than 0. Standard Web servers use port number 80, but this port could be used for other processes. Select a port that isn’t being used for anything else. Requires an application restart.</td>
</tr>
</tbody>
</table>
Window Settings

In the **Window** tab you can specify the monitor being used to display the Touch Factory Player main window, when running in Standalone mode, the transparency of the display and the stroke size for the touch drawing tool.

![Figure 6.13 Touch Factory Player Settings - Window Tab](image)

The settings are described in the table below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch Overlay Screen</td>
<td>Enter or select the number of the display monitor being used for the Touch Factory Player main window, when in Standalone mode.</td>
</tr>
<tr>
<td>Opacity</td>
<td>Enter or select the level of transparency for the Touch Factory Player main window. Low values are useful for testing purposes, particularly when only one monitor is used and Touch Factory Player is being run and displayed on the same machine with a virtual output. Valid values: 1 to 100 Default value: 70</td>
</tr>
<tr>
<td>Line Stroke Size</td>
<td>Enter or select the thickness for the touch drawing/highlighter. Valid values: 1 to 50 Default value: 3</td>
</tr>
</tbody>
</table>
Interaction Settings

In the Interaction tab you can modify the touch settings. Touch Factory can detect actions from the user using a standard mouse input or a touchscreen. Touch mode is more sensitive than Mouse mode but only works in newer touch displays. For testing purposes, we recommend using Mouse mode, since it is compatible with most of the touch devices and you can use a standard mouse to trigger Touch Factory interactions.

🌟 The default values for the interaction settings are strongly recommended unless Touch Factory is not running properly in your system.

The settings are described in the table below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Use the drop-down to select the input mode.</td>
</tr>
<tr>
<td></td>
<td>Valid values: Mouse and Touch</td>
</tr>
<tr>
<td></td>
<td>Default: Mouse</td>
</tr>
<tr>
<td>Minimum Drawing Distance (px)</td>
<td>Enter or select the minimum distance in pixels (sensitivity) between consecutive touch actions that is going to be used for drawing a straight line between both points.</td>
</tr>
<tr>
<td></td>
<td>Valid values: 5 to 100</td>
</tr>
<tr>
<td></td>
<td>Default value: 32</td>
</tr>
<tr>
<td>Minimum Multitouch Distance (px)</td>
<td>Enter or select the minimum distance in pixels (sensitivity) between two consecutive touch actions to detect a multi-touch interaction.</td>
</tr>
<tr>
<td></td>
<td>Valid values: 5 to 100</td>
</tr>
<tr>
<td></td>
<td>Default value: 5</td>
</tr>
<tr>
<td>Minimum Scaling Distance (px)</td>
<td>Enter or select the minimum distance in pixels (sensitivity) between the two fingers while scaling a multi-touchable object.</td>
</tr>
<tr>
<td></td>
<td>Valid values: 5 to 200</td>
</tr>
<tr>
<td></td>
<td>Default value: 20</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Drawing Interval (ms)**    | Enter or select the amount of time in milliseconds between the drawing of one line and the next. This parameter works together with the minimum drawing distance in pixels to set the sensitivity on the drawing/highlighter functionality.  
Valid values: 10 to 1000  
Default value: 50                                                               |
| **Rotation Sensitivity**     | Enter or select a value to increase/decrease the sensitivity of a multi-touch rotation action.  
Valid values: 0.01 to 2.00  
Default value: 0.50                                                             |
| **Dragging Sensitivity**     | Enter or select a value to increase/decrease the sensitivity of a multi-touch drag action.  
Valid values: 0.001 to 2.00  
Default value: 1.00                                                              |
| **Scaling Sensitivity**      | Enter or select a value to increase/decrease the sensitivity of a multi-touch scale action.  
Valid values: 0.001 to 2.00  
Default value: 0.002                                                              |
| **Minimum Scale**            | Enter or select the minimum scale value of an object if resizing it. This prevents resizing an element to such a small size that the user will not be able to interact with it.  
Valid values: -1.000 to 1.000  
Default value: 0.100                                                              |
| **Default Transition Duration (frames)** | The default duration in frames for a transition from one scene to another.  
Default value: 25                                                               |
Client Settings

In the **Client** tab you can specify the data port, IP address and Remote Port that will be used to send the frame buffer image from the XPression machine to the remote device, as well as the image resolution.

![Figure 6.15 Touch Factory Player Settings - Client Tab](image)

The settings are described in the table below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Port</td>
<td>Enter or select the number for the UDP port on which Touch Factory Player will listen for incoming remote clients messages. Applies to <strong>Server Mode</strong> only. This setting must match the setting for the Data Port in the Network Settings tab of the Touch Factory settings.</td>
</tr>
<tr>
<td>Remote Client 01 (PC/Ethernet)</td>
<td></td>
</tr>
<tr>
<td>Enable Streaming - PC</td>
<td>Select to enable streaming the output frame buffer frames (at approximately one frame per second) from XPression to the client application. Requires Touch Remote license.</td>
</tr>
<tr>
<td>IP (01)</td>
<td>Enter the IP address of the remote client PC.</td>
</tr>
<tr>
<td>Port (01)</td>
<td>Enter or select the port number of the remote client PC. The default port is 9997.</td>
</tr>
<tr>
<td>Image Quality (01)</td>
<td>Select the resolution of the frames that are streamed from XPression to the client application. Frames are streamed at approximately one frame per second. The options are: • Low (this is the default and recommended setting) • Medium • High</td>
</tr>
</tbody>
</table>
Saving Settings

Touch Factory Player settings are saved as a `touchfactory.cfg` file in `C:\XPressionApps\Touch Factory Player\`.

**To save your settings:**

1. At the bottom of the Settings screen, click **OK**.
   
   A confirmation dialog box opens to let you know your settings were successfully updated.

   Some settings require an application restart to take effect. These settings are marked with an asterisk (*). If you have changed any of these settings, you will get a confirmation dialog box asking if you would like to restart the application.

2. In the confirmation dialog box, click **OK**.

---

### Setting Description

**Remote Client 02 (Tablet/Wi-Fi)**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Streaming - Tablet</td>
<td>Select to enable streaming the output frame buffer frames (at approximately one frame per second) from XPression to the client application. Requires Touch Remote license.</td>
</tr>
<tr>
<td>IP (02)</td>
<td>Enter the IP address of the remote client tablet.</td>
</tr>
<tr>
<td>Port (02)</td>
<td>Enter or select the port number of the remote client tablet. The default port is 9998.</td>
</tr>
</tbody>
</table>
| Image Quality (02)    | Select the resolution of the frames that are streamed from XPression to the client application. Frames are streamed at approximately one frame per second. The options are:  
                       | • Low (this is the default and recommended setting)                                                                                           |
                       | • Medium                                                                                                                                 |
                       | • High                                                                                                                                 |

---

**Remote Client 02 (Tablet/Wi-Fi)**

Enable Streaming - Tablet | Select to enable streaming the output frame buffer frames (at approximately one frame per second) from XPression to the client application. Requires Touch Remote license. |
| IP (02) | Enter the IP address of the remote client tablet. |
| Port (02) | Enter or select the port number of the remote client tablet. The default port is 9998. |
| Image Quality (02) | Select the resolution of the frames that are streamed from XPression to the client application. Frames are streamed at approximately one frame per second. The options are:  
                       | • Low (this is the default and recommended setting)                                                                                           |
                       | • Medium                                                                                                                                 |
                       | • High                                                                                                                                 |
Starting Touch Factory Player in Server Mode

The application mode is selected in the General tab of the Settings dialog. For more information see General Settings.

In Server mode, Touch Factory Player works in conjunction with a number of other applications, so you will need to launch the following applications before starting Touch Factory Player:

- XPression BlueBox
- XPression Gateway
- XPression Remote Sequencer
- Newsroom Computer System (NCRS) MOS workflow
- XPression Touch Factory Client

To start Touch Factory Player in Server mode:

1. Launch XPression BlueBox, followed by XPression Gateway, XPression Remote Sequencer and your NCRS MOS workflow.
   These applications will automatically communicate with each other.
2. In the NCRS application, load your XPression project.
3. In the XPression Remote Sequencer, from the Connection Group drop-down, select the group containing the XPression engine.
4. Also in the XPression Remote Sequencer, from the Rundown Selection drop-down, select the appropriate NCRS rundown.
5. In the XPression Remote Sequencer, double-click the scene you want to take online.
6. From the desktop icon or the Start menu, launch Touch Factory Client
7. From the desktop icon or the Start menu, launch Touch Factory Player.
   Touch Factory Player will run in the background and place an icon in the Windows system tray.
   By default, it will listen to UDP Port 9093 for a Touch Factory Client (Remote) device.
8. Right-click the grey Touch Factory Player icon in the system tray and select Add Touch Project (.tsf).
9. Navigate to your XPression project file and click Open.
   The scene selected in the XPression Remote Sequencer is displayed on the Touch Factory Player monitor and can now be controlled by the player. The Touch Factory Player icon in the system tray changes to red. When the scene goes offline, the icon in the system tray will turn back to gray until another touch scene goes online.
Starting Touch Factory Player in Standalone Mode

The application mode is selected in the **General** tab of the **Settings** dialog. For more information see **General Settings**.

In **Standalone** mode, Touch Factory Player works in conjunction with XPression, so you will need to launch XPression Studio or XPression BlueBox first and then start Touch Factory Player.

**To start Touch Factory Player in Standalone Mode:**

1. Launch the XPression project you want to control with Touch Factory Player.
2. In the XPression project, click on the **Sequence** tab (or press **F4**) and load the touch scenes into the sequencer.
3. Launch Touch Factory Player from the desktop icon.
   
   Touch Factory Player will run in the background and place an icon in the Windows system tray.
   
   By default, it will listen to UDP Port 9093 for a Touch Factory Client (Remote) device.
4. Right-click the grey Touch Factory Player icon in the system tray and select **Add Touch Project (.tsf)**.
5. Navigate to your XPression project file and click **Open**.
6. In XPression, in the **Sequence** tab, double-click the scene you want to take online.

   The selected scene is displayed on the Touch Factory Player monitor and can now be controlled by the player.

   The Touch Factory Player icon in the system tray changes to red. When the scene goes offline, the icon in the system tray will turn back to gray until another touch scene goes online.

**Closing Touch Factory Player**

You can close the Touch Factory Player without closing XPression, as described below.

**To close Touch Factory Player:**

1. Right-click on the Touch Factor Player icon in the system tray and select **Exit**.
   
   **OR**
   
   Press **Shift + Esc**.
2. In the **Confirmation** dialog that opens, click **Yes**.

**Keyboard Shortcuts for Running Touch Factory Player in Standalone Mode**

Here are some useful shortcuts for operating Touch Factory Player in **Standalone** mode:

- **Shift + Esc**: Close Touch Factory Player
- **Ctrl + F**: Add a project
- **Ctrl + R**: Remove a project
- **Ctrl + W**: Open the **Settings** window
Notes:
Notes:
Notes:
Contact Us

Contact our friendly and professional support representatives for the following:

• Name and address of your local dealer
• Product information and pricing
• Technical support
• Upcoming trade show information

Technical Support

Telephone: +1 613 • 652 • 4886
After Hours Emergency: +1 613 • 349 • 0006
Email: techsupport@rossvideo.com

General Information

Telephone: +1 613 • 652 • 4886
Fax: +1 613 • 652 • 4425
Email: solutions@rossvideo.com
Website: http://www.rossvideo.com

Visit Us

Visit our website for:

• Company information and news
• Related products and full product lines
• Online catalog
• Testimonials